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Document Conventions
Bold Typeface

Objects of actions in procedures appear in bold typeface. Note the following example:

Select the Update button.

Warnings

Warning

A Warning alerts you to a potential serious outcome, adverse event or safety hazard. Failure to observe 
a warning may result in death or serious injury to the user or patient.

Cautions

Caution

A Caution alerts you to where special care is necessary for the safe and effective use of the product. 
Failure to observe a caution may result in minor or moderate personal injury or damage to the product 
or other property, and possibly in a remote risk of more serious injury.

Notes

A Note contains additional information on the product’s usage.
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Introduction
The Patient Information Center iX (PIC iX) Multi-Patient View allows you to see patient information, wherever it is 
convenient for you, by way of a secure application.

Log On
Your IT administrator provides the web site URL, your user name and password. When you access patient data, 
an entry is added to the PIC iX Clinical Audit Log for additional security. Your system may be configured so that 
a generic user is logged on at all times, so no additional login is necessary.

Multi-Patient View Main Screen
When you log on, you may see a default Main Screen. The Main Screen can show waves, numerics, and alarms from 
multiple patients, as they are added to each sector. The amount of data visible in each sector depends on the screen 
resolution and the size of the sector.

Warning

PIC iX Multi-Patient View is not intended for primary alarming. The waveforms are delayed and there are no audible 
alarms.
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Main Screen Sector
The Main Screen is divided into an area for each patient, called a sector. The default layout shows two columns, each 
with four sectors. The top caption bar shows the bed label, patient name, resuscitation status (if added at the 
monitoring host), and active alarm banners.

The sector shows current waves and numerics. These are determined by a priority catalog and are not configurable. The 
amount of data that can display depends on the size of the sector.

1 Bed Label

2 Patient Name. If the patient is assigned to a patient group, the name is outlined in the assigned group color.

3 Resuscitation icon

4 Technical/INOP alarms

5 Red and yellow patient alarms by priority

6 Sector body

1 3 4 52
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Setting Up the Main Screen
In the Multi-Patient View Main Screen, move your cursor over a sector until the Setup button appears. If a patient is 
already in the sector, a Patient View button also appears (see “Patient View” on page 9). To add or change a bed label 
or change the Main Screen layout, select the Setup button in the sector.

The Setup window displays two tabs: Sector Assignments and Layout. 

Sector Assignments
Select the Sector Assignments tab in the Setup window to assign beds to sectors. From the drop-down list at the top 
of the window, select units that you have access to on the server. You may need to open a different web site to see 
patients on a PIC iX servers at different software revisions.

1 Select the unit name from the drop-down list to view the list of beds available to assign to a sector.

2 Select the bed label to assign to the sector. Bed labels that are already assigned are shaded gray.

3 Select Assign Unit to assign all sectors of the selected unit. The sectors are assigned starting top to bottom of 
the first column, in alphabetical order.

4 Select the bed and then select Clear Sector to clear the bed label from the selected sector.

5 Select Close or the red X in the top right to close the Setup window.

1
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Layout
Select the Layout tab in the Setup window to change the number of columns and rows in your Main Screen layout.

Caution

It is possible to make a sector too small to see data or a wave. Only choose the number of columns and sectors that 
allow for desired viewing of waves and data. This also depends on your screen resolution.

.

1 Select the number of columns and sectors from the Sector Layout drop-down list. You can choose from one 
to four columns and up to eight sectors per column, for a maximum of 32 sectors. The default layout is 2 x 4, 
two (columns) with four (sectors) per column, for a total of eight sectors.

2 Select the format of the patient name from the Patient Name Format drop-down list. If you do not want the 
sector to show patient identification, select None.

3 Select the Close button or the red X in the top right to close the Setup window.

1

3

2
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Patient View
After a patient is added to a sector, the Patient View button is visible when the sector is in focus. The Patient View 
provides a detailed view of the waves, numerics, and alarms for measurements that are being monitored. From the 
Patient View, you can access the Strip chart to annotate, print, or copy strips. You can also view PIC iX Web 
retrospective data.
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Patient Strips
Select Patient Strips in the Patient View to review waves associated with the last 20 alarms/events, or to view the most 
recent stored waves. This application opens with the most recent alarm strip. Annotation can be made and printed or 
exported.

1 Select the alarm to view from the drop-down list. Only alarms cached since the time the sector was added are 
available to view. For older alarms, use Alarm Review in Web Review.

2 Select the Show current check box to show the most recent stored waves.

3 Select Patient View to return to Patient View.

4 Select Web Review to view all stored data in retrospective review applications.

5 Select Print to send a 30-second strip to the assigned printer.

6 If configured, select Export to copy and paste the displayed strip to the Electronic Medical Record.

7 Select the Clip Waves check box to minimize wave overlap. Clear the check box to see full amplitude waves.

8 Select the Calipers check box to open the electronic calipers (eCalipers) measurement tool. See “Electronic 
Calipers (eCalipers) Measurement Tool” on page 11.

9 Use the right and left arrows to navigate the 30-second strip.

10 Select the waves to display from the Waves drop-down list. Default is ECG waves.

1 2
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Electronic Calipers (eCalipers) Measurement Tool
Select the Calipers check box in the strip tile to open the electronic caliper tool for ECG measurements.

Note — Annotations, comments, and measurements that you enter in Multi-Patient View are not stored at the PIC iX 
Physio Server and are not stored locally.

11 Select the calibration bar on the wave to change the wave gain.

1 Click the vertical line where you want to start the caliper measurement, then drag the double arrow to the end 
point of the measurement.

2 Select a label to add to the strip, such as Complete heart block or Atrial Fibrillation.

3 Type up to 30 characters to print on bottom of the strip.

4 Select the measurement button on the left to add the value on the right. Choices are: PR, QRS, RR, QT, 
QTc, and Pause.

5 Select Reset to clear the measurements.

6 Select Annotate to add all measured fields to the bottom of the strip.

7 Select Cancel to close the eCalipers dialog box.

2
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Web Review
The Multi-Patient Web review application opens with Alarm Review. You can choose other review applications in the 
top right side of the window. The selected review application is highlighted in orange.

Applications

1 Selected bed label and Patient Name

2 User Name

3 Change the user password.

4 Log out of Multi-Patient View.

5 Select a different application.

Select To

Patient Selection Return to the Patient List to choose a different patient.

Alarm Review See all alarm strips for a selected View Duration, up to 48 hours.

General Review View compressed waves, strips, graphic trends or tabular trends, with corresponding 
alarms and arrhythmia events, up to 7 days.

Cardiac Review View ECG Full Disclosure, ST Snippets/Map and ECG Statistics in addition to 
General Review elements.

12-Lead Capture Review Review all 12-lead ECG captures taken either at the bedside monitor or the PIC iX.

Patient Window See waves, numerics and alarms of selected patient; view a strip – make caliper 
measurements and print or copy to a clipboard to paste into patient documentation. 
Not available on the IntelliVue FlexCare patient monitor.

1

5
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Alarm Review
Alarm Review displays all stored alarms and saved strips up to 48 hours. The application displays a strip in the top 
section of the window and a tabular list of alarms on the bottom section of the window. An alarm count above the 
tabular list corresponds to the selected View Duration and Alarm Filter.

1 Select to return to Patient View.

2 Select to return to Patient Strips.

3 Select to open a Print dialog box that permits printing the strip.

4 Select the Clip Waves check box to minimize wave overlap. Clear the check box to see full amplitude waves.

5 Clear the ECG Filter check box to see the ECG wave at 0.05 to 40 Hz. Select the check box to keep the wave 
on a single flat baseline.

6 Use the single- and double-arrow buttons to move through the 30-second strip.

7 Select the Previous and Next buttons to review strips in order, rather than selecting an individual alarm.

8 Select a page number to view additional alarms.

9 Select the alarm type from the Alarm Filter drop-down list, then select the alarm from the tabular list. 
Default is All Strips.

1
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General Review
General Review shows all patient monitoring data for up to seven days. You can use multiple data formats to view and 
correlate two different data types. For example, you can view compressed strips with graphic trends, or view detailed 
wave strips with alarm and events. The figures and tables in this section describe the tiles and controls that are available 
in the General Review application.

Tiles Available in General Review
The following tiles are available in the General Review application.

10 Select the time period from the View Duration drop-down list. Choices are 1 to 48 hours. 

Note — To view older alarms, see the Event tile in General Review application.

11 Select or clear the check boxes in the Waves pane. You can display up to four waves. Default is ECG waves.

12 Select the strip wave speed from the Speed drop-down list. Default is 25.0 mm/s.

13 Select the wave size from the Wave Gain drop-down list. Choices are x1 to x4. Default is x1.

Tile Definition

Compressed Wave Default of primary ECG wave compressed for 12-minute duration.

Event List of all alarms and events for a specific event type, within selected View Duration.

Graphic Trend Linear trends of selected parameters. Default is Heart Rate.

Strip Detailed view of waves for a given time period; strip is 30 seconds in duration. See 
Alarm Review for details of available controls.



PIC iX Multi-Patient View Quick Guide

15

Compressed Wave Tile

Event Tile

Tabular Trend Displays a list of vital signs sourced during the selected View Duration.

Timeline Select an area anywhere in the timeline to change the time focus of the displayed data.

1 Select the Strip view from the Change Tile drop-down list.

2 Select the duration of the compressed wave view from the Wave Duration drop-down list. Default is 
12 minutes.

3 Select the wave size from the Wave Gain drop-down list. Choices are from x1 to x4. Default is x1.

4 In the Waves panel, select up to four waves to display in the strip. Default is the primary ECG wave.

5 Select the double arrows to navigate the compressed wave to a previous or next wave duration, i.e. 12 minutes.

6 Select anywhere in the compressed tile to change the time focus to correlate with other data types. A red 
rectangle indicates the corresponding time selection.

1 In the Change Tile drop-down list, select the Graphic Trend, Tabular Trend, or Multi-Lead tile.

2 In both the top and bottom tile, select the data type to view in the Event Groups pane.

3 Select or clear specific events in the selected event group to add or remove events in the view.

Tile Definition

6

1

2

3

4

5

3

1

2

4

5 6



PIC iX Multi-Patient View Quick Guide

16

Graphic Trend Tile

Tabular Trend Tile

4 Select anywhere in the tile to change the time focus, shown with a black cursor (thin vertical line).

5 Select the list events in view from the Select Current Event drop-down list. Default is the current event based 
on time focus.

6 Navigate to the next or previous event as you view the tile above, such as with the Strip tile or the Compressed 
Wave tile.

1 Select Event, Tabular or Multi Lead tile from the Change Tile drop-down list.

2 Choose the parameter to display on the left side of the tile from the Left Parameter drop-down list. HR, if 
available, is the default.

3 Choose the parameter to display on the right side of the tile from the Right Parameter drop-down list. SpO2, 
if available, is the default.

4 For the left-side parameter, select the Show Histogram check box to display a histogram in addition to the 
graphic trend.

5 Select anywhere in the tile to change the time focus, shown with a black cursor (thin vertical line).

1 In the Change Tile drop-down list, select the Tabular Trend, Graphic Trend, or Multi Lead tile.

2 Choose the tabular interval from the Tabular Interval drop-down list. Default is the NBP interval, which only 
shows vital signs with an NBP.

3 Select any column to change the time focus, indicated with dark gray shading.

5
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Strip Tile
The Strip tile provides a detailed view of waves for a given time period. The strip is 30 seconds in duration. The Strip 
tile controls are the same as those in the Alarm Review application. See “Alarm Review” on page 13.

Timeline

Cardiac Review
Cardiac Review is similar to General Review but includes additional tiles, including Multi-Lead and 12-Lead Full 
Disclosure, ST Snippets, and ECG Statistics. These additional tiles are described below. For descriptions of the tiles 
that are also in General Review, see “General Review” on page 14.

1 Select the View Duration of the Event, Tabular Trend, and Graphic Trend tiles, shown in the white area. 
Default is 12 hours.

2 Select the Timeline Duration shown in gray. Default is 24 Hours.

3 Select the double arrows to navigate back or forward by one Timeline Duration, up to seven days.

4 Select the single arrows to navigate back or forward by one View Duration.

5 Select anywhere in the timeline to change the time focus, shown with a black cursor (thin vertical line).

1

2
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Tiles Available in Cardiac Review

Tiles Only in Cardiac Review

Multi-Lead Tile

Tile Definition

Compressed Wave Default of primary ECG wave compressed for 12-minute duration.

Event List of all alarms and events for a specific event type, within selected View 
Duration.

Graphic Trend Linear trends of selected parameters. Default is Heart Rate.

Strip Detailed view of waves for a given time period; strip is 30 seconds in 
duration. See Alarm Review for details of available controls.

Tabular Trend Displays a list of vital signs sourced during the selected View Duration.

Timeline Select an area anywhere in the timeline to change the time focus of the 
displayed data.

Tile Definition

Multi-Lead Displays a retrospective review of waves for all available ECG leads. Multi-Lead or 
12-Lead Full Disclosure.

Event tile Signal Quality 
Indicator row

For Cardiac events, the tile includes a 12-Lead Signal Indicator row (see figure above). 
Colors represent the signal quality: bright green indicates good quality, yellow for fair, 
and gray for poor. A grid in the row indicates 10-wire diagnostic ECG waves.

ST Snippets Displays one-minute averaged ST snippets, shown in Standard or Cabrera Format.

ECG Statistics Displays all available ECG statistical data generated by the Philips ST/AR algorithm. 
For example, Percent of time paced, or Atrial Fibrillation, or Heart Rate Variability 
statistics.

1
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ST Snippets Tile

1 Select Compressed Wave, Strip, or Multi-Lead tile from the Change Tile drop-down list.

2 Select the tile layout from the Format drop-down list. Default is 3x4 with one rhythm wave (1R).

3 Select the wave size from the Wave Gain drop-down list. Choices are x1 to x4. Default is x1.

4 Select the Chest Gain. Based on Wave Gain; choose Half or Full. Default is Full.

5 Select the wave speed from the Speed drop-down list. Default is 25 mm/sec.

6 If the selected format includes a rhythm wave (R), select the 10-second Rhythm Waves to display.

7 Select or clear the Cabrera check box to show Cabrera or Standard format.

8 If the selected format includes an ST Map, select the ST Map Scale.

9 Use the single- and double-arrow buttons to move through the 30-second strip.

10 Clear the ECG Filter check box to see the ECG wave at 0.05 to 40 Hz.

11 Select the Clip Waves check box to minimize wave overlap. Clear the check box to see full amplitude waves.

1 Select Graphic Trend, Tabular Trend or Multi Lead tile from the Change Tile drop-down list.

2 Select the tile layout from the Format drop-down list. Default is 3x4 with one rhythm wave (R).

3 Select the wave size from the Wave Gain drop-down list. Choices are x1 to x4. Default is x1.

4 Select the wave speed from the Speed drop-down list. Default is 25.0 mm/s.

5 Select the Show Measurements check box to display ST measurement points with a dotted line.

6 Select the Show Baseline check box to show the baseline wave and value in yellow.

7 Select the Cabrera check box to use Cabrera format. Clear the check box to use Standard format.

8 If the selected format includes an ST Map, select the scale from the ST Map Scale drop-down list.

9 Use the arrow buttons to navigate forward and backward in time.

10 Select the Clip Waves check box to minimize wave overlap. Clear the check box to see full amplitude waves.

1
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ECG Statistics Tile

12-Lead ECG Capture Review
The 12-lead ECG Capture Review application allows you to review all diagnostic captures within the Philips Patient 
Monitoring System.

The following figure and table describe the available controls in the 12-lead ECG Capture Review application.

1 Select the Graphic Trend, Tabular Trend or Multi Lead tile from the Change Tile drop-down list.

2 Select the interval of each column in the tile from the Trend Interval drop-down list. Some statistics are only 
available utilizing the default interval of Algorithm Interval, which is generally about one minute.

3 Select a column to change the time focus.

1
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Prior Data
If data has been collected from the monitoring system in more than one patient stay, during either a previous admission 
or from a different PIC iX unit than the current unit, a drop-down list is displayed next to the name in the applications.

To view data from one stays, select the stay from the drop-down list. Each stay on the list includes the unit and 
duration of the stay.

The caption bar changes from black to teal and displays Prior Data in the caption bar. When you are done reviewing 
stored data, select the current patient stay from the drop-down list.

1 The Previous Page and Next Page arrows are only available if the capture requires more than one page.

2 Select High and Low pass filters from the Filters drop-down list.

3 Select limb gain from the Limb Gain drop-down list. Choices are from x1 to x4. Default is x1.

4 Select chest gain from the Chest Gain drop-down list. Based upon Wave Gain; select Half or Full. Default is 
Full.

5 Select the Strip wave speed from the Speed drop-down list. Default is 25 mm/s.

6 Select the tile layout from the Format drop-down list. Default is 3x4 with one rhythm wave (1R).

7 Select the 10-second rhythm waves to display from the Rhythm Waves drop-down list. Choices depend on 
the selected format.

8 Select the date/time of capture.
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